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Greetings TLSCC
members—Happy
Spring! I can’t believe
this is my last
presidential column—
my term has flown by
and it has been an honor to serve
as your President.
As I reflect back on the last two years, I think
we’ve come a long way and accomplished
quite a bit as a Board and Chapter. I’m
proud of many of our achievements but want
to highlight three that were personal goals of
mine as President:
• Budget: we actually have a healthy
operating budget! This board took a very
conservative, no nonsense approach to our
budget and we have a healthy operating
budget as a result. I want to thank Megan,
our Treasurer for making sure that we were
always operating in the black, for making
us stick to the budget and for getting us an
“A+” with National by submitting all of our
financial reports on time and accurate to the
penny.
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• Membership recruitment and retention:
we continue to keep our ratio of planners
to suppliers better than 50% and continue
to bring in new members. This is no small
feat because of budgets and cutbacks
but I attribute our success to Janet, her
committee and our awesome members!
Please continue to help spreading the word
about all the neat things SGMP is doing here
in our Capitol city. Please continue to bring
those guests (and future members) to our
meetings.

and to the ideals and principles of SGMP.
We served well together as a Board and
I value each and every one of you and
cherish the friendships I have formed with
each of you.

• Education: LaToya, as Program/
Education Chair and her Committee did an
outstanding job and brought us top notch
educational programs. LaToya spearheaded
the website (keeping it up to date); going
green with online evaluations and paperless
announcements during monthly meetings;
sending out program announcements
and reminders; and brought us noon time
meetings based on membership input.
Thank you LaToya for your boundless
energy and leadership!

I encourage each of you to “get connected,
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and attending the meetings. Thank you
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Board Buzz................................10
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affordable
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I could go on and on about our
achievements, but suffice it to say I am
proud of the work that this board has done.
I thank Rob, Connie, Megan, LaToya,
Stacy, Janet and Kathy for your support and
service. I thank you for your time, energy,
dedication and commitment to our Chapter

So far, we have 25 members of the Lone
Star Capital Chapter heading to the National
Education Conference (NEC), May 22-24,
2013 in Orlando, Florida. I’m excited about
the agenda and look forward to seeing all of
you in Orlando!
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PROFESSIONAL DEVELOPMENT SEMINAR 2013
PDS 2013

2013 SGMP Professional Development Conference

SAVE THE DATE
Texas Hill Country and Texas Lone Star Capital Chapter:

What Legends Are Made Of!
August 16–18, 2013
Y.O. Ranch
Kerrville, Texas

2013 PROFESSIONAL DEVELOPMENT
SEMINAR SCHEDULE AT A GLANCE
FRIDAY, AUGUST 16, 2013
1 pm		
Bus leaves Austin at 1 p.m.
2:15 pm
Break stop in HYE for some corn
juice and gelato 			
ice cream
3:30 pm
Arrive in Kerrville
6 pm		
Welcome Fandango
SATURDAY, AUGUST 17, 2013
6:30 AM CHOW
9-11 am
Town Meetings
11:30 AM Lunch
3:15 pm
Tour and Town Meetings at Inn of the
Hills
3:30-6 PM Downtown Kerrville
6:30 PM Ho Down Dinner

Get Ready for Some LEGENDARY EDUCATION
and OLD WESTERN HOSPITALITY!

SUNDAY, August 18, 2013
6:30 am
CHOW
9-11 AM Town Hall Meetings & Loadin’ er Up

Visit WWW.SGMPAUSTIN.ORG for schedule, sponsorship opportunities, and other information.
SGMP Texas Lone Star Capital Chapter
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CHAPTER MEETINGS

Jim Zukowski, CGMP

The April Monthly Education Meeting was held at
the Holiday Inn Midtown, 6000 Middle Fiskville Rd.,
Austin, Texas. The sponsors of the meeting were the
Holiday Inn Midtown and the Laredo CVB. Before the
presentation began, attendees were provided with
an array of wonderful foods and beverages at the
newly-remodeled hotel. The Laredo CVB staff made
a batch of the official drink of Laredo, the Ojo Rojo.
Theresa Campos, the sales representative who
coordinated the event is the SGMP representative at
the property.
The speaker at the April meeting was Carol Grainger,
who spoke on “Finding Sponsors to Help Fund
Programming. Carol’s objectives for the presentation
included the following for attendees:
•
•
•

Applying social networking skills to solicit
sponsors and exhibitors
Using the existing client/contact list to find
supporting sponsors, and
Using the speaker’s/trainers contacts to fund
supporting sponsors.
SGMP Texas Lone Star Capital Chapter

Carol provided a handout of her PowerPoint
presentation which contained a wealth of resources
for attendees. One of the highlights of her resentation
was outlining sponsorship benefits. It is extremely
important for government meeting planners to show
sponsors what they will gain out of the sponsorship.
She also provided exercises, asking for listings
of the different types of sponsors one would
seek depending on the nature and scope of the
conference.

She also provided a list of online fundraising
resources and described the different levels of
sponsorship and the benefits provided with each.
With meetings and conferences changing due to
organizational downsizing, re-development of current
staff, and the pressing need for more training, the use
of sponsorships is at an all-time high.

MAY MONTHLY MEETING

by Bob Nichols, CMP
SGMP TLSCC May 9, 2013 Event:

Susan Schaefer

Dedi Kavanaugh
and the Marriott
North Round
Rock are hosting
the SGMP Texas
Lone Star Capital
Chapter May
9, 2013 event.
This is a unique
opportunity for the
chapter to have
a lunch meeting
which will happen
11:30 a.m. to 1:00
p.m. This month
Susan Schaefer
travels from Old Hickory, Tennessee to share the
core competency of Ethics through the Art & Science
of FAM Trips. The government meetings professional
has several governing ethics that do not apply to
their peers in the corporate and private landscape.
Contractors, suppliers, and government employees
need to be aware of the various boundaries,
guidelines, and policies, as well as the importance of
familiarization (FAM) trips to decision making.

CHAPTER MEETINGS

April Monthly Chapter Meeting
April 11, 2013

Susan’s career has spanned thirty years including
event planning, fundraising, and travel planning. For
the past eight years she has owned and operated
her own travel agency in Tennessee with a focus
on group travel. As a travel professional, Susan
contributes articles to Travel Research Online, Be the
Boss and CYL (Cover Your Life) Magazines, offering
her industry expertise as a guest writer.
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COMMUNITY INVOLVEMENT
Let’s Talk Trash Clean Sweep 2013

Holiday Inn Ladybird Lake

Accenture

Catherine Weir

On Saturday, March 9, about
a dozen SGMPers and their
guests assisted sorting frozen
foods at the Capital Area Food
Bank. We learned how to judge
spoilage, weigh and crate frozen
meats, pre-packaged meals
and baked goods. We mainly
learned how precisely the CAFB
has the retrieval, organization,
storage and donation of food
down to a science. At the
conclusion of the morning the
Volunteer Coordinator was
able to tell us how much food
and how many people would
be fed from our efforts. We all
left feeling good about how we
spent our Saturday. Do you
remember what you were doing
that morning? Perhaps next time
YOU will join us. Volunteers
included: Stacey Janecka, CMP
& her daughter & another friend,
Megan Hamilton and husband,
Kathy Casarez & friend, Karen
Krc, Catherine Weir, David Price,
and Robert Gonzalez.

COMMUNITY INVOLVEMENT

Capital Area Food
Bank- March

Karen Krc

From the lovely shores of
Ladybird Lake to the more
recently developed Rainey
Street District, a small band of
SGMP volunteers participated in
“Clean Sweep 2013”. The group
gathered at the Holiday Inn
on Ladybird Lake at 9:00 a.m.
Armed only with rubber gloves,
plastic bags and a collective
spirit to make a difference, the
volunteers collected trash and
recyclables throughout this South
Austin neighborhood.
Each April, “Keep Austin
Beautiful” (KAB) hosts the “Clean
Sweep”, a city-wide service
day spanning 140 sites in 31
zip codes throughout Austin,
resulting in over 29 tons of
trash being removed and more
than 11,600 hours contributed.
There were approximately 5,000
volunteers who joined together
to give back to the city of Austin.
SGMP will be back at the Holiday
Inn in 2014 to participate again.
I hope to see everyone there!

Everyone is encouraged
to visit our
SGMP TLSCC
Facebook page!
It has pictures, updates, &
videos!
Make sure to visit,
post comments,
and like our page at:
www.facebook.com/sgmpaustin

SGMP Texas Lone Star Capital Chapter
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MEMBERSHIP REPORT

Denise Guerra
Government Meeting Planner
Railroad Commission of Texas
Veronica Larson
Government Meeting Planner
Railroad Commission of Texas

Membership Report
Well, it is the absolute craziest time of the
year in Austin! The Texas Legislature is
in session and you just never know what
will happen when those folks convene and
attempt to make informed decisions that will
impact all members of our chapter in some
way!
Thankfully, the craziness has not impacted
the ratios and numbers of members in our
local chapter. I previously explained to you
that SGMP chapters are required to have a
balance of planners and suppliers.
Our ratio for the first quarter of this year has
remained consistent with where we were
at the end of 2012. 51.9% of our members
are government or contract planners! While
the numbers are consistent, a few members
have not renewed their membership BUT
there were new members that joined to keep
the ratio consistent.
I would like to clarify a membership issue
SGMP Texas Lone Star Capital Chapter

MEMBERSHIP REPORT

NEW MEMBERS:

for all of you. Planners generally own their
membership in the organization. Supplier
memberships are generally owned by the
company they work for. So, when you review
the new member list below, some of the
names may be familiar to you. It is most
likely that their job/employer/status has
changed in some way.
With that in mind, please join me in
welcoming our newest members!!
If you have any questions about your
membership in this organization please call,
write or text! I’d be happy to visit with you!
Janet Spies
Membership Director
Texas Lone Star Capital Chapter
(512) 461-3236 cell
Jspi456@yahoo.com

Belinda Wolf
Government Meeting Planner
Railroad Commission of Texas
Monica Castillo
Supplier
El Paso CVB
Brandi Ambrose
Supplier
Hyatt House
Karen Krc
Contract Planner
Accenture
Sandra Moro Sleeper
Government Meeting Planner
University of Texas at Austin
David Price
Supplier
Doubletree by Hilton Austin
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PROFESSIONAL DEVELOPMENT
By Robert Nichols, CMP

During the course of any given month event
planners and suppliers read numerous articles
from many resources designed to improve
the processes needed to assure successful
events through individual growth. This growth
is the cornerstone to successful outcomes
for any organization. Too often we hear the
comment, “My vote won’t count so why vote?”
This prompts an inquiry of the individual’s
desired return on investment through exercise
of the voting process. In this instance voting is
our voice. Parents exercise consistent efforts
to aid, guide and improve their child’s learning
process. In many instances immediate results
are not evident. This does not stop the act of
consistently offering support and guidance.
Reminding others of their value is a consistent
need requiring time and effort regardless of
the position we fill. What value is placed on
a penny? Consider the value of five pennies,
then remember five nickels equal a quarter
and four quarters equal a dollar. Using this
basic theory, consider the outcome of a
thousand-plate seated dinner. Success at
these events is the result of each server
working to assure their charges receive
the utmost in customer service due to their
individual effort. It is that individual effort that
results in exceeding expectations. At the next
event you attend, take a moment to single out
one of your servers and thank them by name.
If they do not happen to have a name badge,

SGMP Texas Lone Star Capital Chapter

prompt them for their name by asking, “What
do we call you besides happy?” Faces light
up as they are specifically identified as an
important part of your day.
The tragedy of the September 11, 2001
events could have been significantly worse
had it not been for the efforts of airline
passengers, fire fighters, police, and Cyril
R. (Rick) Rescorla, a British born survivor of
the La Drang Valley, one of the most savage
and significant battles of the Vietnam War.
As the vice president for group security of a
major stock-brokerage firm in the World Trade
Tower, he regularly exercised the staff in
emergency evacuation drills. The majority of
that staff survived because of this individual’s
effort.
Walt Disney’s Magic Kingdom refers to every
employee as a Cast Member. A significant
approach, as they are reminded daily of
their integral part of the Disney Experience.
Housekeepers, maintenance crews, street
sweepers, sanitary engineers, character
performers and executives are all members
of the cast. It is a simple way to consistently
state to everyone in an organization that their
role is the most important one. They make
the Magic.
In the days when the circus traveled by train
setting up operations in open fields it took
each member to be the best they could be.
The main event tent covering an area of

three football fields was put up in less than
three hours. The individual efforts of many
workers made this possible. In support of this
massive undertaking was a red, two and a
half ton truck operated by a few men. Three
sides were folded up and tables were set up
at the back and side of the truck. This truck
was one large dishwasher. The men scraped
the dinnerware, placed it in this massive
dishwasher. After washing, the dinnerware
was stored ready for the next meal. They had
a direct impact on the success of this tent
going up without being part of the physical
act. What outcome would the circus have
faced had these dishwashers not taken their
job seriously? It becomes very relevant in any
dining event when the dishwashing staff does
not believe their job is important.

PROFESSIONAL DEVELOPMENT

THE VALUE OF ONE

Our challenge is to encourage everyone to
bring their best daily through strategies that
inspire, energize, and shift their perspective.
As the Disney Organization inspires their
staff by identifying them as Cast Members, so
must we provide the same inspiration to all
with whom we work and play so they are true
contributors to our personal and professional
efforts.
The penny may have little or no value to
many. These very same people may place
little or no value on certain positions within
an organization. The value of one equals the
difference between failure and success, a hohum or a magical experience.
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MEETINGS & UPCOMING EVENTS

After the session, attendees will be able to:

JULY:
SILENT AUCTION
July 11, 2013
5-7 p.m.
Omni Southpark
4140 Governor’s Row
Austin, TX 78744
http://www.omnihotels.com/findahotel/austinsouthpark.aspx

1. Understand new programs and laws that affect our industry
2. Implement programs and procedures to take
advantage to changes in state law
3. Brief other co-workers and supervisors on
important governmental affairs issues that
affect their business.

MEETINGS & UPCOMING EVENTS

JUNE:
Volunteerism Presentation:
Being a Great Volunteer,
Leading & Organizing Your Team
of Volunteers

SEPTEMBER:
Legislative Affairs Update

by Allison Brickley

Session Description:
Program is less than one hour because it’s
being combined with the installation of officers
and a recap from NEC. The recap will start off
the meeting followed by the installation and
Ally will close the program with getting involved
in the chapter committees and in the Austin
community.
SGMP Texas Lone Star Capital Chapter

September 12, 2013
11:30 AM - 1:00 PM
Boy Scouts of America
12500 N. I-35
Austin, TX 78753
http://www.bsacac.org/about/facility_rental
A legal update on changes to Texas law from
the last legislative session, plus news on governmental affairs from the federal level. Topics
discussed will include the Texas lodging and
travel industry’s legislative affairs agenda, and
news on programs that affect our industry.

Guest Speaker and Back By Popular Demand:
Justin Bragiel, General Counsel
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MEETINGS & UPCOMING EVENTS
“What to Do in Case of a Hotel Fire: Fire Safety Month”
October 10, 2013
Guest Speaker:
Tony Callaway
Assistant Fire Marshal
Travis County Fire Marshal’s Office
Session Description:

MEETINGS & UPCOMING EVENTS

OCTOBER:

In this presentation, attendees will learn about hotel and public meeting
building fire code requirements; inspections and compliance regulations; and overall safety tips and rules that every hotelier and meeting
planner need to know.
After the session, attendees will be able to:
1. Be aware of entrances and exits of hotel/meeting space that are in
compliance with fire code standards
2. Identify/have a plan for safe evacuation of attendees/guests in case
of an emergency
3. Be able to identify required safety and fire code requirements “systems” in a public building - meaning fire alarms, fire extinguishers,
and/or smoke control system. What’s required by law in a public/
private meeting space?

SGMP Texas Lone Star Capital Chapter

page 8

FUNDRAISING
February Raffle
Donated by:
Laura Little, Courtyard Marriott Dallas
Jackie Ray, Omni Corpus Christi
Marge Pettway, 1859 Historic Hotels
Megan Hamilton, Sheraton Austin
Jana Ibarra, Crowne Plaza, Austin
Bob Nichols, Governors Center
Vanessa Kager, Corpus Christi CVB
Trish Hooker, Westin Domain
Connie Ramos, Homeward Suites
Theresa Campos, Holiday Inn, Midtown Austin
Vanessa Bay, Doubletree North
Kathy Casarez, State Bar of Texas

FUNDRAISING

Thank you to our Sponsors…

No March Meeting
April Raffle
Donated by:
Theresa Campos - Holiday Inn, Midtown
Anita Zukowski retired
Aileen Ramos - Laredo CVB
Janet Spies - JFS Events
Kim Kizer - Texas County & District Retirement System
Rhonda Durst - retiree
Catherine Wier - Holiday Inn, Lady Bird Lake
Jana Ibarra - Crowne Plaza, Austin
Erik Hanson - Ideal Productions
Bob Nichols - Governor's Center
Lavita Miller - La Torretta Spa & Resort, Conroe
David Price - Doubletree North
Jo Anne Gonzalez - Texas Workforce Commission
Jo Ann Brown - Texas Workforce Commission

SGMP Texas Lone Star Capital Chapter
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BOARD BUZZ & FINANCIAL REPORT
BOARD BUZZ & FINANCIAL REPORT

By Kathy
Casarez

The TLSCC
Board was
excited to
welcome
SGMP
National
President Rob Coffman to
Austin last month. The board
hosted a dinner for Rob on
Wednesday, April 10th at
Landmark Restaurant inside the
beautiful Sheraton Austin Hotel.
A special thank you goes out
to Treasurer Megan Hamilton,
Director of Sales at the Sheraton
for sponsoring this event.
We had a great time and
showed our guest some real
southern hospitality. We had
a great conversation with Rob
over dinner. He was eager to
hear our ideas on where the
organization is now and the
direction it needs to take in the
future. Rob also shared his
concerns with us on how the
organization as a whole can
maintain its current members as
well as attract new ones.
SGMP Texas Lone Star Capital Chapter

After dinner Board President,
Kim Kizer and Director Planner,
Stacy Janecka, took Rob on a
whirl- wind tour of Austin.
We discovered Rob loves Dr.
Pepper as he shared with us
that he had the opportunity to
tour the Dr. Pepper Museum in
Waco. Rob also attended our
April meeting held at the Holiday
Inn Midtown on April 11th. He
made a brief presentation and
attended the entire program.
The meeting was filled to
capacity and the food and
program were excellent. We
would like to thank Rob for
taking the time to visit us in
Austin and we welcome him
back anytime.
On a special note, I would like
extend a special thank you to
Theresa Campos, Sales Director
with the Holiday Inn Midtown
and Aileen Ramos with the
Laredo CVB for sponsoring
our April meeting. They did a
fantastic job!

TREASURER
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PARTNERS IN EDUCATION CONFERENCE 2013
Carol Abbott, Chair

“Life is all about how you handle Plan B. Plan B…It’s
the true test of character.” – Suzy Toronto

those that stayed until the end and enjoyed Three
Fools on Three Stools.
We had the privilege of hearing three outstanding
keynote speakers, whose messages encouraged us
to be kind to each other with the words we choose,
and to remember that laughter is indeed the best
medicine. Each was unique in their message but
equally inspiring making us laugh and smile.
The supplier tradeshow was well attended. I heard
several exhibitors express satisfaction about the
potential business opportunities they obtained during
the show.

gracious President/CEO Tim Dammon and Program
Director Elizabeth Hancy shared their story with
us. We were very happy to offer a donation to their
worthy organization.
My thanks and praises go to:
•

•

•

“There is more than one path through the palms to
the beach.” - Hawaiian Proverb

•

Don’t you just love quotations that seem to reach out
and grab you when you are experiencing a situation
similar to the quote?

•

As chair of the 2013 PIE conference I found
myself, along with North Texas chapter president
Sue Thomason, repeatedly saying “We are going
to have to go with Plan B…whatever Plan B is!”
This conference had its ups and downs and at
times seemed impossible. However with awesome
teamwork, creative thinking by many and even a
Wall of Wine, I am very happy to report that the
conference was a great success!

The education we received from the breakout
speakers was invaluable to both meeting and
hospitality industry professionals. Praises for all our
speakers were overheard throughout the weekend.
Who would have thought bowling could be such a
blast?!? Saturday night The International Bowling
Museum hosted a fun-filled evening including the
Chapter Challenge, which was won by none other
than our own “King Pin” Rob Coffman with thanks to
former SGMPer Anna Murphy!

There were many elements that contributed to our
success which I would like to share with you. The
Sheraton Arlington provided a warm welcome for
our attendees, from the outstanding service to the
guestrooms and the delicious food. Friday night’s
opening reception was held in the coolest room ever
and a great time seemed to be had by all – especially

This year’s charitable contribution was to Angel
Flight. This organization is comprised of a group of
pilots who believe in the benefit of volunteering. They
arrange free air transportation on their airplanes
for legitimate charitable medically related needs for
individuals and health care organizations. Their very

SGMP Texas Lone Star Capital Chapter

PIE 2013

Partners in Education
Conference 2013

the five chapter presidents and co-chairs for
giving their support, sharing their expertise with
me during the impossible times, and sharing our
sigh of relief at the end
the conference committee who endured many
conference calls, going over and above their
various duties, and who never stopped telling me
everything would be o.k.
to President Sue Thomason, who let me lean on
her so many times (which is not easy because
she is so short), made me laugh when I needed
to laugh, endured my “whining”, and was a
trouper during the conference while her mother
was in the hospital
to our wonderful list of sponsors who offered
their very generous support and who we are
extremely grateful to
and finally to all of you who attended the
conference, purchased raffle tickets and auction
items, and reminded me why we endured all the
issues we had – to visit with old and new friends,
gain new ideas and refresh old ones, and to learn
once again the importance of kindness, giving,
sharing, and laughter.

I challenge all of you to support the Houston Gulf
Coast chapter next year for PIE 2014.
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SUPPLIER NEWSLINE
THE PARKING SPOT:

Sales Manager
Plano Convention and Visitors Bureau

The Parking Spot has a special rate for
State of Texas travelers. You’ll save 25% off
regular rates at all Parking Spot locations
in Texas! The Parking Spot has clean and
secure airport parking facilities in Austin,
Dallas (DFW & Love Field), and Houston
(Bush Intercontinental & Hobby). Shuttles
run continuously, so getting to and from
the airport is quick and easy. The Parking
Spot provides State of Texas travelers: 24hour access to your vehicle, no blackout
periods for State of Texas rates, timely
shuttle service to and from airport terminals,
luggage assistance to and from shuttles,
complimentary USA Today newspaper at
check-in, complimentary bottled water at
check-out, valet service at many locations,
free online reservation capabilities, and the
Spot Club Exec frequent parker program.

Kay Summerville

Our full-service, 300-room Hilton Granite
Park broke ground on April 1.
(Artist’s rendering above.)
The hotel should be complete and open for
business in the Fall of 2014. We hope to be
able to announce much more at the October
SGMP that the Plano CVB is sponsoring!

NEW! The Parking Spot is offering Double
Spot Club Points exclusively to all Spot Club
Exec card holders May 1st - June 30th,
2013. Registration is not required and the
Double Points will automatically be credited
to your account during the promotion.

SUPPLIER NEWSLINE

News from Plano:

WACO MEETINGS MARKETPLACE:

The 2nd Annual Waco Meetings
Marketplace will take place on Wednesday,
May 22 from 10 AM – 2 PM in the Brazos
Ballroom of the Waco Convention Center.
This is a free tradeshow aimed at bringing
together meeting and event planners with
the vendors they need for a successful
event.
Anyone who plans a meeting is invited
to attend including those who plan
conferences, weddings, quinceañeras,
workshops, or sporting events. Attendees
may be from corporations, non-profit groups,
or colleges and may be volunteer planners
or full-time professionals.
For more information, contact Carla
Pendergraft, CMP at 254-750-5806 or e-mail
at carlap@ci.waco.tx.us.

Order Your State of Texas discount card,
view State of Texas rates and make feewaived parking reservations at: http://bit.ly/
theparkingspotStateofTexas

SGMP Texas Lone Star Capital Chapter
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planner spotlight
BY Karen Krc, Accenture

The Texas Lone Star Chapter is proud
to Spotlight Carolyn Salinas. Carolyn
is a planner with the Texas Workforce
Commission (TWC). Her title is Program
Specialist IV, working in Workforce and
Board Support. She has been making a
difference with her exceptional skill set
and uplifting attitude at TWC for over 14
years. Carolyn’s roles include planning,
coordinating and implementing the TWC
Workforce Forum and assisting with their
Annual Conference. Carolyn is instrumental
in the design of the Workforce Forum
which seeks to increase workforce staff

capacity through knowledge and information
exchange.
Carolyn was born and raised in
Fredericksburg, Texas, as were both of
her parents. She attended St. Mary’s
Catholic Church, which was established in
1846 and is actually listed in the National
Record of Historic Places. Carolyn attended
Fredericksburg High School, proud home
of the Battlin’ Billies! She continued her
education at St. Mary’s University in
San Antonio earning a Bachelor of Arts
degree in Public Justice (Criminal Justice).
Carolyn graduated Magna Cum Laude
and is a member of the St. Mary’s Alumni
Association. She then attended the College
of the Southwest in Hobbs, New Mexico
earning a Master of Science in Education,
Guidance and Counseling.
While living in New Mexico, Carolyn worked
with disadvantaged groups (adults and
youths) and provided guidance to assist
them in becoming self- sufficient. Carolyn
says “It is a very rewarding experience to
help a person develop professionally and
personally and accomplish goals which
impacts their life in a positive way.” Carolyn
lived in the “Land of Enchantment” for
almost 20 years before returning to our great
Lone Star State.
Carolyn has a daughter named Consuelo
(nicknamed Connie who is a senior at the
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University of Texas at San Antonio. She is
following in mother’s footsteps with a major
in Criminal Justice and a minor in Sociology.
Needless to say, she is extremely proud of
her daughter. Carolyn has been blessed
with a large and close-knit family and has
six siblings all living in the Fredericksburg
area. Carolyn enjoys gardening, walking,
attending Mass, and spending time with
her family and friends. She is a sports
enthusiast and especially loves watching the
San Antonio Spurs.

planner spotlight

Planner Spotlight on...
Carolyn Salinas

Carolyn joined SGMP in 2008 and has
been an active participant in all of the
SGMP events, conferences and community
involvement. She is grateful to SGMP for
the opportunities and support that it offers.
She has learned so much from both her
fellow planners and the hotel suppliers.
Carolyn believes that no matter what career
field, one must strive to learn new skills and
embrace new challenges. That is an attitude
she shares with others.
Carolyn’s personal goals include continuing
to grow spiritually, staying strong in faith, be
forgiving and always help others. She wants
to be the best mother, sister, aunt, friend, coworker and SGMP member that she can be.
Success in all those areas is already been
proven. We are very lucky to have such a
great achiever and caring member in our
chapter!
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supplier Spotlight

by Bob Nichols

His education is unique. While obtaining
a degree at NAU he was also a full time
Marriott employee earning the degree
via online courses. It was during an “Intro
to Hospitality” course while attending
the community college that a spark was
generated which brought him into the
hospitality industry. That, in turn, brought
him to the Marriott Team where he continues
to grow.

He and his wife were able to start checking
things of their bucket list beginning with a
trip to Alaska in September 2012. While
they search for their next big adventure
they are enjoying their Texas adventure.
Introduce yourself to Ryan and enhance
your SGMP experience.

supplier Spotlight

Supplier Spotlight on...
Ryan Garcia
Marriott Team Professional

If it involves the great outdoors, Ryan, his
wife of eight years and their two young ones,
Kara and Emma, can be found energized by
activities such as kayaking and volleyball.
He is an active volunteer staff member with
his local church in New Braunfels serving as
Director of Creative Arts. His team is tasked
with managing all media related items.

Born and reared in Tucson, Arizona, Ryan
Garcia of the Marriott Organization and his
wife decided to offer their growing family
a new adventure in Texas about six years
ago. A graduate of Mountain View High
School he obtained his degree in Hotel and
Restaurant Management from Northern
Arizona University.

SGMP Texas Lone Star Capital Chapter

Ryan plans to continue his chosen path
with the Marriott Organization. No specific
position is on the horizon, only to continue
making his best effort daily wherever service
in the industry is offered. He would like to
be with Marriott another 20 years, which
would put him at 28 years of service. He
would also like to remain in Texas. Knowing
change happens he knows God will have an
impact on his family’s final location.
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MEETING PLANNING TIPS
•

Jim Zukowki, CGMP

Meeting event planners face hundreds of
challenges, so here are someone else’s
innovative solutions to some common
challenges.
Planning Tips:
•

Reduce your room attrition fees. A few
days or so before your event, find out if
your hotel is booked. If so, you can use
that to get them to waive any attrition
fees you may have incurred.

•

Arrive an hour early for site visits. Show
up at least one hour before a scheduled
site visit unannounced. In that time, walk
around and try to interact with staff as
if you are a guest and not a seasoned
traveler.

•

Look into the restaurants; eat there if
you have time. You may want to ask for
recommendations for local restaurants
(just to see the reaction on the faces of
the staff.) You can call off an inspection
when the property doesn’t come close
to your standards for the event being
planned. You’ve saved your time and
that of the sales manager.

SGMP Texas Lone Star Capital Chapter

Use a tree stanchion for lanyards.
As most government planners know,
string/lanyard badges can get tangled
easily and create quite a mess in the
registration area. You can go to most
department stores and find a necklace
stanchion (stand) in the jewelry section
or purchase them online and use them
at all of your conferences and events.
You reduce the possibility of knots in the
lanyards and they make the registration
area look even more professional and
organized.

•

Reserve the last rows of the meeting
room to fill front rows. Nothing looks
worse than empty tables and chairs in
front of the meeting stage at a particular
event. Put reserved signs on the last two
rows of banquet tables or chairs in the
meeting room. This forces attendees to
look at tables and chairs closer to the
stage or podium. Once the front tables/
chairs are filled, pull the reserved signs
and fill the tables and chairs in the back
of the room.

•

Use a fishing tackle box for a supply
kit. Fill it with miscellaneous items you
need for your meeting such as be pens,
stapler/staples, paperclips, box cutter,
scissors, Velcro, batteries, sewing kit
and/or emergency kit. Everything is
organized and in one spot to help save
time. Make sure you have a list of the

contents and restock it when you return
home from the event. Do this before you
find yourself at the next meeting and find
that something is missing!
Adapted from tips received at 		
www.ConventionPlanit.com.

MEETING PLANNING TIPS

Event Planning

ON A PERSONAL NOTE...

Grandma Kristi Griffith’s bundle of joy Emma Grace
Battaglia arrived on May 7th at 10:21a.m. weighing in
at 7lbs 1oz at 20 inches long.

Congratulations!
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Our Goal is to Make You Look Good on Paper

2301 West Anderson Lane, Suite 102 ● 512.719.3600
ken@yes-printing.com ● yes-printing.com ● orders@yes-printing.com

For over 30 years, the Governor’s Center has provided
professional development services for managers and
leaders at all organizational levels. Our programs offer
political strategies to meet the needs and challenges of
leaders in an ever changing environment.

SGMP Texas Lone Star Capital Chapter
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BOARD & COMMITTEES

Society of Government Meeting Professionals
2013-15 Texas Lone Star Capital Chapter Committees
Awards & Scholarship Committee

Education Committee

Chair: Rob Casias, CMP
Email: President@sgmpaustin.org
Phone: (512) 454-7300

Board Liaison: Veronda L. Durden
Email: education@sgmpaustin.org
Phone: (512) 438-2635

Communications Committees:

Finance Committee

Newsletter Committee

Chair: Megan Holtz Hamilton, CGMP, MBA
Email: treasurer@sgmpaustin.org
Phone: (512) 404-6950

Board Liaison: Jackie Ray
Email: Newsletter@sgmpaustin.org
Phone: (361) 886-3563
Website Committee

Board Liaison: Stacy Janecka, CMP
Email:webmaster@sgmpaustin.org
Phone:512-475-4600
Public Relations Committee

Chair: Carolyn Salinas
Email: PR@sgmpaustin.org
Phone:(512) 463-5556
Community Involvement Committee

Board Liaison: Joe Bedsole
Email: CommunityInvolvement@sgmpaustin.org
Phone: (512) 656-4229
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Fundraising Committee

President
Kim Kizer

Treasurer
Megan Hamilton, CGMP

Director (Planner)
Janet Spies

Texas County and District
Retirement System
PO Box 2034
Austin, TX 78768
Phone: (512) 637-3286
e-mail:
president@sgmpaustin.org

Sheraton Austin Hotel
701 East Eleventh Street
Austin, TX 78701
Phone: (512) 404-6950
e-mail:
treasurer@sgmpaustin.org

JFS Events
7208 Curpin Cove
Austin, TX 78754
Phone: (512) 272-5602
e-mail:
membership@sgmpaustin.org

1st Vice President
Robert Casias, CMP

Secretary
Kathy Casarez

Director (Supplier)
LaToya Scott

National Guard Association State Bar of Texas
of Texas
Austin, TX 78711-2487
3706 Crawford Avenue
Phone: (512) 427-1863
Austin, TX 78731
e-mail:
Phone: (512) 454-7300
Fundraising@
e-mail:
sgmpaustin.org
Newsletter@sgmpaustin.org
2nd Vice President
Connie Ramos

Director (Planner)
Stacy Janecka, CMP

Board Liaison: Susan Ruiz
Email: Fundraising@sgmpaustin.org
Phone: (512) 936-0466
Membership Committee

Board Liaison: Louis Ledoux
Email: Membership@sgmpaustin.org
Phone: (512) 936-3146
Nominations & Elections Committee

Chair: Kim Kizer
Email: nominationselections@sgmpaustin.org
Phone: (512) 637-3286

Homewood Suites by Hilton Austin South
4143 Governors Row
Austin, TX 78744
Phone: (512) 445-5050
e-mail:
CommunityInvolvement@
sgmpaustin.org

Office of Attorney General
of Texas
P. O. Box 12548
Austin, TX 78711-2548
Phone: (512) 475-4600
e-mail:
webmaster@sgmpaustin.org

BOARD & COMMITTEES

Chapter Board

Doubletree Suites by HiltonAustin
303 West 15th Street
Austin, TX 78701
Phone: (512) 505-4056
e-mail: education@sgmpaustin.org
Advertising Prices
(4-C Ads Only)
Full Page.....................$250.00
Half Page....................$150.00
Quarter Page................$75.00
Advertising Inquiries
Please Contact Rob Casias, CMP,
National Guard Association of Texas
512-626-0344 (C)
rcasias@ngat.org
SGMP Lone Star News is a quarterly
publication of the Texas Lone Star Capital
Chapter of the Society of Government
Meeting Professionals.
Graphic Design/
Electronic Publishing
Document Engine
© Copyright SGMP Texas Lone Star Capital Chapter. All articles and photography
are property of the SGMP Texas Lone
Star Capital Chapter and may not be
used without the written permission of the
Newsletter Chair.
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RECIPE OF THE QUARTER
RECIPES

Sweet & Sour Brisket
Jim Zukowski, CGMP

Ingredients:
• 5 – 7 lb. brisket
• 2 16-ounce cans stewed tomatoes-cut up
• 2 8-ounce cans sauerkraut
• 2 cups applesauce
• 4 tablespoons brown sugar
Directions:
Rub brisket with a dry rub. I use Montreal Steak Seasoning. Bake brisket uncovered in a
250 degree oven allowing the fat and juices to render. This may take 1 – 2 hours. Drain as
much of the fat as possible. In the meantime, heat the first four ingredients in a pan. Spoon
some of the mixture over the brisket; immediately cover the brisket with foil and continue
baking. Monitor the brisket adding more of the sauce as necessary. Reserve enough of the
sauce for serving with the brisket and suggested mashed potatoes. When the brisket is
tender, remove from oven, remove foil, and let stand for 10 minutes. Slice the brisket on to
a serving plate, cover with some of the sauce, and serve with mashed potatoes. Enjoy!

SAVE 25% ON AIRPORT PARKING
AT THE PARKING SPOT
U.S. Military & Government Employees receive 25% off airport parking plus free reservations

OUR BEST ONLINE OFFERS

Present a US Government or Military ID or Spot Club Exec card to upon exit to receive discount. Order your Spot Club Exec card at www.theparkingspot.com/usgov
• Shuttles every 5-7 minutes • Covered, open-air and valet* parking • Online reservations • Well-lit and secured • Open 24/7 • Earn Free Parking with The Spot Club

The Parking Spot has Texas airport parking covered with locations in Austin, Dallas (DFW & DAL) & Houston (IAH & HOBBY).
For turn-by-turn directions, freeYou
reservations
andtomore
goour
tobest
www.theparkingspot.com/usgov
shouldn’t have
searchinformation,
the web to get
offers.
And
you
never
have
to
pre-pay
to
get
our
best
offer
at
www.theparkingspot.com.
©2012 PRG Parking Management, LLC. The Parking
Spot and the spotted shuttle design are trademarks
of TPS Parking Management, LLC. *Valet parking
only available at some locations.

SGMP Texas Lone Star Capital Chapter
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TECHNO NEWS

by Estes Sher
Senior Sales Manager
Hilton Americas Houston
Spring cleaning is a good idea for
your office, home and your computer.
Here are 4 Free & Easy Steps to
clean up and speed up your Windows
based computer:

Click on: My
Computer►Right Click C:
Drive►Properties►Tools►Errorchecking►Check now►Check disk
options (BOTH)►Automatically Fix
System Errors ►Scan for and attempt
recover of bad sectors►Start

Run: CCleaner and Click on
Registry icon (on left side of screen)
Steps:
Click on Scan for Issues and then
click on Fix Selected Issues
Enjoy your newer, faster, cleaner
computer and wonder why you didn’t
do this sooner!

TECHNO NEWS

Spring Cleaning...For Your Computer!

Run: Disk Cleanup
Purpose: Remove unnecessary,
temporary and duplicate files
Steps:
Run: Disk Defragmenter
Purpose: Organize your hard drive Click on: Start►Programs►
data so it can be retrieved more easily Accessories►System Tools►Disk
Clean Up
and faster
Steps:
Click on: Start►Programs►A
Run: Registry Cleaner
ccessories►System Tools►Disk
Defragmenter►Analyze►Defragment Purpose: Organize the “brains” of
your windows operating system for
faster performance
Download: CCleaner from this
Run: Error-checking
website►www.piriform.com/ccleaner
Purpose: Fix system errors and
recover bad sectors
Install: CCleaner
Steps:
SGMP Texas Lone Star Capital Chapter
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COMMUNITY OUTREACH
National Charity
Jim Zukowski, CGMP

The 2013 National Charity is The
Mustard Seed of Central Florida.
For over 30 years this group has
collected donated items such as
furniture, appliances, household
items, and toys; anything that
helps create a home for such
recipients as the homeless, victims
of domestic violence and disasters,
welfare recipients, the elderly,
the disabled, the ill, and others
struggling to redevelop a home in
Central Florida.
The mission of this exceptional
organization is to help rebuild the
lives of families and individuals
who have suffered disaster or
personal tragedy. They provide
household furnishing and clothing
while being environmentally
responsible to the community.

component of the organization’s
ability to provide much-needed
support to the Orlando area
community.
Donations are being collected by
all of the SGMP chapters across
the country.

COMMUNITY OUTREACH

National Education
Conference

During a hands-on event to be
held on Wednesday, May 22 at the
NEC, volunteers will assist with
clothing and goods separation
for distribution. Buses will pick
up the volunteers at the Shingle
Creek Hotel early in the morning
with the event lasting from 9 a.m.
until 11:00 a.m. Light to possibly
heaving lifting may be required.
Go to the SGMP national
website www.sgmp.org for more
information on The Mustard Seed.

The Mustard Seed has a small
staff of only eight full-time
employees operating three
trucks to pick up donated items.
Loyal volunteers are the critical
SGMP Texas Lone Star Capital Chapter
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Plain expectations
Long meetings, old facilities, nothing close by, nothing to do, same old, same old.

Plano expectations
Our SGMP partners are important to Plano; we understand your travel needs and
the fact that budgets are tight. Plano’s hotel community honors state and federal
per diems and with more than 700 restaurants we can address every taste and
budget. Plano’s accessibility via highway or air (Love Field or Dallas Ft. Worth
International Airports) makes it easy for you to get here. As for planning, our
full-service CVB is here to help you every step of the way to find a venue that best
fits your needs – and best of all our services are free. From big meetings to
small workshops, Plano’s the Place for your event!

1-800-81-plano • planocvb.com

SGMP Texas Lone Star Capital Chapter
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SEE YOU THERE...

Date of Meeting

Topic/Program Coordinators

May 22-24, 2013

SGMP 31st NEC – Orlando, FL

June 13, 2013

NEC Update/Board Installation/Volunteerism
Speaker: Scholarship Winners and Ally Brickley

July 11, 2013

Summer Silent Auction
Omni Hotel Southpark

August 16-18,
2013

PDS
YO Ranch
Kerrville, TX

September 12,
2013

Legislative Affairs
Speaker: Justin Bragiel
Boy Scouts of America Center

SGMP Texas Lone Star Capital Chapter

UPCOMING MEETINGS

SGMP TEXAS LONE STAR CAPITAL CHAPTER
2013-2014 MONTHLY MEETING SCHEDULE
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